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Notes, Cautions and 
Warnings 

For the protection of your product, and in order to ensure that 
you benefit from its full functionality, this model has been 
designed to operate only with genuine original toner cartridges. 
Any other toner cartridge may not operate at all, even if it is 
described as “compatible”, and if it does work, your product's 
performance and print quality may be degraded.

Specifications subject to change without notice. All trademarks 
acknowledged.

Note
A note provides additional information to supplement 
the main text. 

CAUTION!

A caution provides additional information which, if 
ignored, may result in equipment malfunction or 
damage.

WARNING!

A warning provides additional information which, if 
ignored, may result in a risk of personal injury.



Introduction

Printer features
• Four models to choose from: B401, B411, B431, B431dn+,

(d denotes Duplex included and n denotes Network Interface 
Card included).

• Memory: 64 MB.

• High speed printing: 

- B401: up to 30 ppm

- B411: up to 35 ppm

- B431: up to 40 ppm

- B431dn+: up to 47 ppm

• Maximum Resolution: 

- B401/B411: 2400 x 600 dpi

- B431: 1200 x 1200 dpi.

• Paper handling: 250 sheets 20-lb. US Bond (75 g/m²).

• Emulations 

- B401/B411: standard Printer Control Language PCL6, 
PCLXL, Epson FX, IBM ProPrinter

- B431: PostScript 3, standard Printer Control Language 
PCL6, PCLXL, Epson FX, IBM ProPrinter.

• Barcodes: embedded for SIDM emulations.

• Flash DIMM: 1 MB for B401/B411 and 4.5 MB for B431 to 
allow the storage of additional fonts or bar codes.

• USB 2.0 High speed and Parallel interfaces. 

• 10/100 BASE-TX Network: B401dn/B411dn and B431dn only.

• Multi Purpose tray for B431: to extend the range of media 
your printer can accommodate; can also be used for manual 
duplexing.
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• Manual Feed tray for B401/B411: to feed single sheets, heavy 
paper stocks, envelopes, other special media and can also be 
used as manual duplex.

Additionally, the following optional features are available:

• 64 and 256 MB RAM DIMM: to extend the main memory of 
your printer and speed up the processing of large files (only 
for B411/B431).

• Second paper tray: to increase your printer’s paper handling 
capacity by 530 sheets (20-lb. US Bond, 75 g/m²) (only for 
B411/B431).
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About This Manual
This manual has been written using more than one printer as a 
model and the illustrations/screenshots reflect this. What you 
see will be appropriate to the model you are using.

Abbreviations Used
The following abbreviations are used in this manual:

ABBREVIATION MEANING

Ctrl Control

dpi dots per inch

DIMM Dual In-line Memory Module

d duplex

n network card installed

LED Light Emitting Diode

NIC Network Interface Card

PCL Printer Control Language

PS PostScript (emulation)

PSE PostScript Emulation

RAM Random Access Memory



Printer Components
Apart from the Operator panels, which are described in the next 
chapter, the B401, B411 and B431 printers look similar from the 
outside.

Front View 

1. Operator panel (B431dn shown)

2. Output Stacker (150 sheets, face down)

3. Output Stacker extension

4. Top cover release button

5. Multi Purpose Tray (only for B431; 50 sheets), shown in 
open position

6. Multi Purpose Tray extension

7. Paper Tray (250 sheets)
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Interior View 

1. ON/OFF switch*

2. LED array

3. Image drum

4. Manual Feed Tray (only for B401/B411, single sheet feed), 
shown in open position

5. Toner cartridge

6. Fuser unit

7. Top cover

* 230V models are equipped with an automatic power off function. When a fixed 
period of time has passed after the printing operation has completed, the printer 
power switch automatically returns to the OFF position and the power turns off. 
However, when the power is turned off by the automatic power function, the 
switch feels heavier when turning the power on again than when turning the 
power on after the power is turned off manually. This is not a malfunction.
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Rear View 

1. Power cable connection

2. Parallel interface connection

3. USB interface connection

4. LAN interface connection (only for B401/B411dn and 
B431dn)

5. Memory panel (to upgrade your printer’s memory RAM 
DIMM)

6. Cooling fan
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Operator Panels 
This chapter describes the function of the operator panel on your 
printer. It is useful to describe the Configuration Tool at this point 
as it provides the B401/B411 with the equivalent of the menu 
control panel on the B431.)

Note
The Configuration Tool was installed as part of the 
software installation described in the Setup Guide 
supplied with your printer.
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B401/B411 Operator Panel 

The B401/B411 operator panel consists of 2 indicating LEDs, an 
LCD (3) and an Online (4) button. The LEDs indicate Ready (1) 
and Attention (2).

Note
For model B431, see page 30
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LED indicators
The LED indicators show the status of the printer and have three 
operating conditions as follows:

• Indicator off

• Indicator on

• Flash 

Both LED indicators come on momentarily when power is 
switched on using the main power switch.

Ready LED (green)

• Indicator on - the printer is on-line and ready to receive data.

• Indicator off - the printer is off-line and cannot receive data.

Attention LED (red)

• Indicator on - this indicates a warning, (e.g. low toner).

• Indicator off - this indicates normal condition.

The meaning of the indicator LEDs when they flash (x) is 
summarized as follows:

STATUS
READY 
LED

ATTENTION 
LED MEANING

Flash x The printer is receiving 
and processing data 
during printing or the 
printer is resetting.

x There is a printing error, 
for example, a problem 
with paper, the cover is 
open or the paper tray is 
empty while a job is 
processing. 

x x There is a minor error with 
the printer, for example, 
toner is low and the image 
drum needs to be 
changed.
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LCD 
The LCD (3) has two rows of up to 16 alphanumeric digits, 
displaying print status and error messages.

Online button
The primary functions of the Online button (4) are activated by 
pressing the switch momentarily and releasing. The primary 
functions are as follows:

• Turning the printer off-line.

• Turning the printer on-line (ready).

• Resuming printing after page overflow.

• Interrupting data processing when the printer is receiving 
and processing data.

• Resuming data processing.

The secondary functions of the Online button are activated after 
turning the printer off line, then pressing and holding the switch 
for four seconds before releasing. The secondary functions are as 
follows:

• Printing the demo and menu pages.

Changing language
The default language used by your printer for display messages 
and for report printing is English. If required, this can be changed 
to:

• Canadian French 

• Latin American Spanish 

Note
Demo and menu pages can also be printed using the 
printer’s Configuration Tool.
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• Brazilian Portuguese 

Configuration Tool 
The Configuration Tool is used to control and change the various 
printer settings.

Using the Configuration Tool 
Viewing or changing the printer settings are carried out as 
follows:

With the printer connected to your computer and plugged in:

1. Click Start > All Programs > Okidata > Configuration 
Tool and select the Configuration Tool. 

2. Click Tools > Register Device. 

3. Be sure the B401/B411 printer is selected, then click 
Register. Click Yes to confirm. 

The B411 appears in the left column.

4. Click the B401/B411 icon in the left panel, then click the 
Device Setup tab.

5. Click the Menu Setting button. 

6. Click USER MENU to pull down a list of the menu items. 

Menu functions 
The B401/B411 Printer Menu allows you to view and change the 
printer’s internal settings. You can think of this as the software 
equivalent of the LCD operator panel.

The settings are grouped into categories or “menus” such as 
Information Menu or Print Menu.

Some of these settings are similar to those found in your printer 
driver or application software. The settings that you can change 

Note
See the Setup Guide supplied with your printer for 
information on how to change the display language.
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using this software act as the printer’s defaults. These can be 
overridden by the settings in your printer driver or application.

For example, if you have set the number of copies in the 
Configuration Tool to one, this will be overridden if you select 
three copies of your document in the printer driver.
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Information menu: B401/B411 Configuration Tool 

This menu provides a quick method of listing various items stored 
within the printer.

ITEM ACTION REMARKS

PRINT MENU MAP EXECUTE

NETWORK EXECUTE B401dn/B411dn 
only

DEMO1 EXECUTE

PRINT FILE LIST EXECUTE

PRINT PCL FONT EXECUTE

PRINT PPR FONT EXECUTE

PRINT FX FONT EXECUTE

PRINT ERROR LOG EXECUTE

USAGE REPORT EXECUTE Is displayed only 
when ‘USAGE 
REPORT’ is enabled 
in the Print 
Statistics Menu
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Print menu: B401/B411 Configuration Tool 

This menu provides adjustment of various print job related 
functions.

ITEM DEFAULT REMARKS

COPIES 1

DUPLEX OFF

DUPLEX LAST PAGE SKIP BLANK PAGE

MANUAL OFF

PAPER FEED TRAY1

AUTO TRAY SWITCH ON

TRAY SEQUENCE DOWN

MEDIA CHECK ENABLE

RESOLUTION 600DPI

TONER SAVE MODE DISABLE

ORIENTATION PORTRAIT

LINES PER PAGE 60 LINES

EDIT SIZE CASSETTE SIZE
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Media menu: B401/B411 Configuration Tool 

This menu provides adjustment to suit a wide range of print 
media.

ITEM DEFAULT REMARKS

TRAY1 PAPERSIZE LETTER 

TRAY1 MEDIATYPE PLAIN

TRAY1 
MEDIAWEIGHT

MEDIUM

TRAY2 PAPERSIZE  LETTER When Tray2 is installed 
(B411 only)

TRAY2 MEDIATYPE PLAIN When Tray2 is installed 
(B411 only)

TRAY2 
MEDIAWEIGHT

MEDIUM When Tray2 is installed 
(B411 only)

MN PAPERSIZE  LETTER

MN MEDIATYPE PLAIN

MN MEDIAWEIGHT MEDIUM

UNIT OF MEASURE  INCH 

X DIMENSION 8.5 

Y DIMENSION 11 
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Syst config menu: B401/B411 Configuration Tool 

This menu adjusts general printer settings to suit the way you 
prefer to work.

ITEM DEFAULT REMARKS

POW SAVE TIME 1 MIN

AUTO POWER OFF 
TIME

6 HOURS 230V-Model only

PERSONALITY AUTO EMULATION

CLRABLE WARNING ONLINE

AUTO CONTINUE ON

MANUAL TIMEOUT 60 SEC

TIMEOUT INJOB 40 SEC

TIMEOUT LOCAL 40 SEC

TIMEOUT NET 90 SEC B401dn/B411dn 
only

LOW TONER CONTINUE

JAM RECOVERY ON

ERROR REPORT OFF

HIGH HUM.MODE OFF
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PCL Emulation: B401/B411 Configuration Tool 

This menu controls the printer’s PCL emulation.

ITEM DEFAULT REMARKS

FONT SOURCE RESIDENT

FONT NO. 0

FONT PITCH 10.00 CPI

SYMBOL SET PC-8

A4 PRINT WIDTH 78 COLUMN

WHITE PAGE SKIP OFF

CR FUNCTION CR

LF FUNCTION LF

PRINT MARGIN NORMAL

PEN WIDTH ADJUST ON

TRAY ID#
PCL MNID

PCL T0ID

PCL T1ID

PCL T2ID

2

4

1

5 When Tray2 is 
installed (B411 
only)
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PPR Emulation: B401/B411 Configuration Tool 

This menu controls the printer’s PPR emulation.

ITEM DEFAULT REMARKS

CHARACTER PITCH 10 CPI

FONT CONDENSE 12CPI TO 20CPI

CHARACTER SET SET-2

SYMBOL SET IBM-437

LETTER O STYLE DISABLE

ZERO CHARACTER NORMAL

LINE PITCH 6 LPI

WHITE PAGE SKIP OFF

CR FUNCTION CR

LF FUNCTION LF

LINE LENGTH 80 COLUMN

FORM LENGTH 11 INCH

TOF POSITION 0.0 INCH

LEFT MARGIN 0.0 INCH

FIT TO LETTER ENABLE

TEXT HEIGHT SAME
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FX Emulation: B401/B411 Configuration Tool 

This menu controls the printer’s FX emulation.

ITEM DEFAULT REMARKS

CHARACTER PITCH 10 CPI

CHARACTER SET SET-2

SYMBOL SET IBM-437

LETTER O STYLE DISABLE

ZERO CHARACTER NORMAL

LINE PITCH 6 LPI

WHITE PAGE SKIP OFF

CR FUNCTION CR

LINE LENGTH 80 COLUMN

FORM LENGTH 11 INCH

TOF POSITION 0.0 INCH

LEFT MARGIN 0.0 INCH

FIT TO LETTER ENABLE

TEXT HEIGHT SAME
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Parallel menu: B401/B411 Configuration Tool 

This menu controls the operation of the printer’s parallel data 
interface.

USB menu: B401/B411 Configuration Tool 

This menu controls the operation of the printer’s USB data 
interface.

ITEM DEFAULT REMARKS

PARALLEL ENABLE

BI-DIRECTION ENABLE

ECP ENABLE

ACK WIDTH NARROW

ACK/BUSY TIMING ACK IN BUSY

I-PRIME 3 MICRO SEC

ITEM DEFAULT REMARKS

USB ENABLE

SOFT RESET ENABLE

SPEED 480 Mbps

SERIAL NUMBER ENABLE
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Network menu: B401/B411 Configuration Tool 

This menu controls the operation of the printer’s 10Base-T/
100Base-TX network interface.

NOTE
This is applicable to the B401dn/B411dn network 
model.

ITEM DEFAULT REMARKS

TCP/IP ENABLE

IP VERSION IPv4

NETBEUI DISABLE

NETBIOS OVER TCP ENABLE

NETWARE ENABLE

ETHERTALK ENABLE

FRAMETYPE AUTO

IP ADDRESS SET AUTO

IP ADDRESS xxx.xxx.xxx.xxx

SUBNET MASK xxx.xxx.xxx.xxx

GATEWAY ADDRESS xxx.xxx.xxx.xxx

WEB ENABLE

TELNET DISABLE

FTP DISABLE

SNMP ENABLE

NETWORK SCALE NORMAL

HUB LINK SETTING AUTO NEGOTIATE

TCP ACK TYPE1

FACTORY DEFAULTS EXECUTE
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Maintenance menu: B401/B411 Configuration Tool 

This menu provides access to various printer maintenance 
functions.

Usage menu: B401/B411 Configuration Tool 

This menu is for information only, and provides an indication of 
total usage of the printer and the expected life left in its 
consumable items. This is particularly useful if you do not have a 
full set of replacement consumables to hand and you need to 
know how soon you will need them.

ITEM DEFAULT REMARKS

MENU RESET EXECUTE

SAVE MENU EXECUTE

RESTORE MENU EXECUTE Displayed in Menu 
when Menu 
settings have been 
stored.

POWER SAVE ENABLE

AUTO POWER OFF AUTO CONFIG 230V-Model only

PAPER BLACK SET 0

DARKNESS 0

SMR SETTING 0

BG SETTING 0

ITEM DEFAULT REMARKS

TRAY1 PAGE 
COUNT 

nnnnnn

TRAY2 PAGE 
COUNT 

nnnnnn B411 only

MN PAGE 
COUNT 

nnnnnn

DRUM LIFE REMAINING nnn 
%

An indication of the remaining 
drum life.
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Printing menu settings
The menu settings can be printed as a menu map as follows.

Using the Online button

1. Press the Online button to take the printer off-line.

2. Press and hold down the Online button for at least four 
seconds, but less than seven seconds.

3. The printer prints a list of the menu settings and a demo 
print page. See “Online button” on page 16.

Using the Configuration Tool

1. Select Start > All Programs > Okidata > 
Configuration Tool and select the Configuration Tool.

2. Click the B411 icon in the left panel. 

3. Click the Device Setting tab.

4. Click the MENU SETTING button.

5. Click USER MENU.

6. Click INFORMATION MENU.

7. Click the EXECUTE button beside PRINT MENU MAP.

The Menu Map prints.

TONER (n.nK) REMAINING nnn 
%

An indication of how much 
toner is left in the cartridge.

ITEM DEFAULT REMARKS
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B431 Operator Panel  

The B431 operator panel consists of a menu driven control panel 
(2 through 6), an LCD display (1) and two LED indicators (7, 8).

Panel Elements
1. Liquid crystal display. (LCD) panel. Two rows of up to 16 

alphanumeric digits displaying print status, menu items in 
menu mode and error messages. 

2. Menu Scroll Buttons. Press briefly to enter the MENU 
mode. Press briefly again to select the next menu. Press 
for more than 2 seconds to scroll through the different 
menus.
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3. Back button. Press briefly to return to the previous 
higher level menu item or exit the menu when in MENU 
mode.

4. OK button. In the ONLINE or OFFLINE mode: press this 
briefly to enter the MENU mode. In the MENU mode: press 
this briefly to select the menu or setting indicated on the 
LCD.

5. Online button. Press to switch between ONLINE and 
OFFLINE status.
Press to exit the menu and displays ONLINE, when in the 
MENU mode. 

6. Cancel button. When printing press to cancel a print job. 
Press to exit the MENU mode and go ONLINE, when in the 
MENU mode. 

7. Ready indicator (green). ON indicates ready to receive 
data. FLASHING indicates processing data. OFF indicates 
Offline.

8. Attention indicator (red). ON indicates a warning (e.g. 
low toner). FLASHING indicates an error, (e.g. toner 
empty). OFF indicates normal condition.

Note
When pressed in Menu mode, the Online button 
returns the printer to ONLINE status. Also when there 
is an error indicating wrong paper size, pressing the 
Online button forces the printer to print.
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The meaning of the indicator LEDs when they flash (x) is 
summarized as follows: 

Menu functions
The Printer Menu allows you to view and change the printer’s 
internal settings.

The settings are grouped into categories or “menus” such as 
Information Menu or Print Menu.

Some of these settings are similar to those found in your printer 
driver or application software. The settings that you can change 
using this software act as the printer’s defaults. These can be 
overridden by the settings in your printer driver or application.

For example, if you have set the number of copies in the printer 
menu settings to one, this will be overridden if you select three 
copies of your document in the printer driver.

Factory default settings are shown in the following tables.

STATUS
READY 
LED 

ATTENTION 
LED MEANING

Flash x The printer is receiving 
and processing data 
during printing or the 
printer is resetting.

x There is a printing error, 
for example, a problem 
with paper, the cover is 
open or the paper tray is 
empty while a job is 
processing. 

x x There is a minor error with 
the printer, for example, 
toner is low and the image 
drum needs to be 
changed.
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Information menu: B431 Printer Menu 

This menu provides a quick method of listing various items stored 
within the printer.

Shutdown menu: B431 Printer Menu 

This menu shuts down the printer.

ITEM ACTION REMARKS

PRINT MENU MAP EXECUTE

NETWORK EXECUTE B431dn only 

PRINT FILE LIST EXECUTE

PRINT PCL FONT EXECUTE

PRINT PSE FONT EXECUTE

PRINT PPR FONT EXECUTE

PRINT FX FONT EXECUTE

DEMO 1 EXECUTE

PRINT ERROR LOG EXECUTE

USAGE REPORT EXECUTE Is displayed only when 
‘USAGE REPORT’ is 
enabled in the Print 
Statistics Menu

ITEM ACTION REMARKS

SHUTDOWN START EXECUTE
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Print menu: B431 Printer Menu 

This menu provides adjustment of various print job related 
functions.

ITEM DEFAULT REMARKS

COPIES 1

DUPLEX OFF

DUPLEX LAST PAGE SKIP BLANK PAGE

PAPER FEED TRAY1

AUTO TRAY SWITCH ON

TRAY SEQUENCE DOWN

MP TRAY USAGE DO NOT USE

MEDIA CHECK ENABLE

RESOLUTION 600 DPI

TONER SAVE MODE DISABLE

ORIENTATION PORTRAIT

LINES PER PAGE 60 LINES

EDIT SIZE CASSETTE SIZE
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Media Menu: B431 Printer Menu 

This menu provides adjustment to suit a wide range of print 
media.

ITEM DEFAULT REMARKS

TRAY1 PAPERSIZE LETTER 

TRAY1 MEDIATYPE PLAIN

TRAY1MEDIAWEIGHT MEDIUM

TRAY2 PAPERSIZE LETTER When tray 2 is 
installed

TRAY2 MEDIATYPE PLAIN When tray 2 is 
installed

TRAY2MEDIAWEIGHT MEDIUM When tray 2 is 
installed

MPT PAPERSIZE LETTER 

MPT MEDIATYPE PLAIN

MPT MEDIAWEIGHT MEDIUM

UNIT OF MEASURE INCH 

X DIMENSION 8.5 INCH

Y DIMENSION 11 INCH 
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System configuration menu: B431 Printer Menu 

This menu adjusts general printer settings to suit the way you 
prefer to work.

ITEM DEFAULT REMARKS

POW SAVE TIME 1 MIN

AUTO POWER OFF 
TIME

6 HOURS 230V-Model only

PERSONALITY AUTO EMULATION

PARA PS-PROTOCOL ASCII

USB PS-PROTOCOL RAW

NET PS-PROTOCOL RAW B431dn only

CLRABLE WARNING ONLINE

AUTO CONTINUE OFF

MANUAL TIMEOUT 60 SEC

TIMEOUT INJOB 40 SEC

TIMEOUT LOCAL 40 SEC

TIMEOUT NET 90 SEC B431dn only

LOW TONER CONTINUE

JAM RECOVERY ON

ERROR REPORT OFF

START UP OFF

HIGH HUM.MODE OFF
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PCL emulation: B431 Printer Menu 

This menu controls the printer’s PCL emulation.

ITEM DEFAULT REMARKS

FONT SOURCE RESIDENT

FONT NO. I0

FONT PITCH 10.00 CPI

SYMBOL SET PC-8

A4 PRINT WIDTH 78 COLUMN

WHITE PAGE SKIP OFF

CR FUNCTION CR

LF FUNCTION LF

PRINT MARGIN NORMAL

PEN WIDTH ADJUST ON

TRAY ID#
PCL T0ID

PCL T1ID

PCL T2ID

4

1

5 When Tray2 is 
installed
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PPR Emulation: B431 Printer Menu 

This menu controls the printer’s PPR emulation.

ITEM DEFAULT REMARKS

CHARACTER PITCH 10 CPI

FONT CONDENSE 12CPI TO 20CPI

CHARACTER SET SET-2

SYMBOL SET IBM-437

LETTER O STYLE DISABLE

ZERO CHARACTER NORMAL

LINE PITCH 6 LPI

WHITE PAGE SKIP OFF

CR FUNCTION CR

LF FUNCTION LF

LINE LENGTH 80 COLUMN

FORM LENGTH 11 INCH 

TOF POSITION 0.0 INCH

LEFT MARGIN 0.0 INCH

FIT TO LETTER ENABLE

TEXT HEIGHT SAME
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FX Emulation: B431 Printer Menu 

This menu controls the printer’s FX emulation.

ITEM DEFAULT REMARKS

CHARACTER PITCH 10 CPI

CHARACTER SET SET-2

SYMBOL SET IBM-437

LETTER O STYLE DISABLE

ZERO CHARACTER NORMAL

LINE PITCH 6 LPI

WHITE PAGE SKIP OFF

CR FUNCTION CR

LINE LENGTH 80 COLUMN

FORM LENGTH 11 INCH

TOF POSITION 0.0 INCH

LEFT MARGIN 0.0 INCH

FIT TO LETTER ENABLE

TEXT HEIGHT SAME
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Parallel menu: B431 Printer Menu 

This menu controls the operation of the printer’s parallel data 
interface. 

USB menu: B431 Printer Menu 

This menu controls the operation of the printer’s USB data 
interface.

ITEM DEFAULT REMARKS

PARALLEL ENABLE

BI-DIRECTION ENABLE

ECP ENABLE

ACK WIDTH NARROW

ACK/BUSY TIMING ACK IN BUSY

I-PRIME DISABLE

OFFLINE RECEIVE DISABLE

ITEM DEFAULT REMARKS

USB ENABLE

SOFT RESET DISABLE

SPEED 480Mbps

OFFLINE RECEIVE DISABLE

SERIAL NUMBER ENABLE
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Network menu: B431dn Printer Menu 

This menu controls the operation of the printer’s 10Base-T/
100Base-TX network interface.

Note
This applies only to the B431dn model.

ITEM DEFAULT REMARKS

TCP/IP ENABLE

IP VERSION IP v4

NETBEUI DISABLE

NETBIOS OVER TCP ENABLE

NETWARE ENABLE

ETHERTALK ENABLE

FRAMETYPE AUTO

IP ADDRESS SET AUTO

IP ADDRESS xxx.xxx.xxx.xxx

SUBNET MASK xxx.xxx.xxx.xxx

GATEWAY ADDRESS xxx.xxx.xxx.xxx

WEB ENABLE

TELNET DISABLE

FTP DISABLE

SNMP ENABLE

NETWORK SCALE NORMAL

HUB LINK SETTING AUTO NEGOTIATE

TCP ACK TYPE1

FACTORY DEFAULTS EXECUTE
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Maintenance menu: B431 Printer Menu 

This menu provides access to various printer maintenance 
functions.

ITEM DEFAULT REMARKS

MENU RESET EXECUTE

SAVE MENU EXECUTE

RESTORE MENU EXECUTE Displayed in Menu 
when Menu settings 
have been stored.

POWER SAVE ENABLE

AUTO POWER OFF AUTO CONFIG 230V-Model only

PAPER BLACK SET 0

DARKNESS 0

SMR SETTING 0

BG SETTING 0
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Usage menu: B431 Printer Menu 

This menu is for information only, and provides an indication of 
total usage of the printer and the expected life left in its 
consumable items. This is particularly useful if you do not have a 
full set of replacement consumables to hand and you need to 
know how soon you will need them.

Printing menu settings
Current menu settings can be confirmed by printing a Menu Map, 
using the control panel.

1. Press the Menu ▲ or ▼ button until the INFORMATION MENU 
is available, then press the OK button.

2. Press the ▲ or ▼ button until the display prompts you to 
print the menu map.

3. Press the OK button to print the menu map. 

4. Press the Cancel or Online or the Back button repeatedly 
to exit the MENU mode. 

ITEM DEFAULT REMARKS

TRAY1 PAGE COUNT nnnnnn An indication of the 
number of pages 
printed from Tray1

TRAY2 PAGE COUNT nnnnnn An indication of the 
number of pages 
printed from Tray2 
(when Tray2 is 
installed)

MPT PAGE COUNT nnnnn An indication of the 
number of pages 
printed from the MPT.

DRUM LIFE REMAINING nnn % An indication of the 
remaining drum life.

TONER REMAINING nnn % An indication of how 
much toner is left in 
the cartridge.
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Paper Recommendations
For guidance on the media you can use with your printer, which 
input tray and which ejection method to use, see the section 
entitled “Paper and tray information” in the “Specifications” 
chapter.

Paper and envelope types
The manufacturer of this printer recommends the following 
guidelines when selecting paper and envelopes for use in your 
printer:

• Paper and envelopes should be stored flat and away from 
moisture, direct sunlight and heat sources.

• Use a smooth finished paper such as copier or laser type 
paper with a Sheffield (smoothness) rating of 250 or less. If 
in doubt, please ask your paper supplier.

• Use paper and envelopes that are designed for use in laser 
type printers.

• The use of heavily laid or textured paper will seriously impact 
on the life of the image drum.

• Do not use very smooth, shiny/glossy paper.

• Do not use heavily embossed headed paper.

• Do not use specially treated papers such as carbon paper, 
non-carbon paper, thermal paper and impact paper.

• Avoid using paper with perforations, cut-outs and ragged 
edges.

• Do not use envelopes with windows or metal clasps.

• Do not use envelopes with self sealing flaps.

• Avoid using damaged or curled envelopes.

Note
The reference to Manual Feed Tray is for the B401/
B411 models and the Multi Purpose Tray is for the 
B431 models.
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Transparencies and adhesive 
labels
The manufacturer of this printer recommends the following 
guidelines when selecting transparencies and adhesive labels for 
use in your printer:

• Always manually feed single sheets using a Manual Feed Tray 
or Multi Purpose Tray.

• Always use rear output.

• Media must be designed for use in laser printers or 
photocopiers and must be able to withstand 392°F (200°C) 
for 0.1 sec. 

• Do not use media designed for use in color laser printers and 
photocopiers. 

• Labels should cover entire carrier sheet.

• Carrier sheet or adhesive must not be exposed to any part of 
the printer.

Postcards
Use the following guidelines when selecting postcards for use in 
your printer:

• Always manually feed single postcards using the Manual Feed 
Tray or Multi Purpose Tray, depending on your printer model.

• Use unfolded double postcards.

• Use postcards designed for use in laser type printers

• Do not use postcards used for ink jet printers.

• Do not use stamped or picture postcards.
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Installing paper

Paper Tray

Tray 1 

• Paper sizes 3.9 inches x 5.8  inches (100 x 148 mm) to 8.5 
inches x 14 inches (216 x 356 mm) 

• Paper weight: 16-32 lb. US Bond (60-120 g/m²)

Optional Tray 2

• Paper sizes 5.8 x 8.3 inches (148 x 210 mm) to 8.5 inches x 
14 inches (216 x 356 mm) 

• Paper weight: 16-32 lb. US Bond (60 -120 g/m²)

Note
If you are topping up the paper in a paper tray, it is 
recommended that you remove the remaining paper 
from the tray first then add the new paper stock 
followed by the paper you removed. This ensures that 
the oldest paper is used first to help prevent paper 
jams.
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1. Remove the paper tray from the printer. 
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2. For loading A4 or Legal size paper, push the lever (2) in 
the arrow direction and extend the paper tray using the 
rear paper support. 

 

Note
Load letterhead paper face down and top edge 
towards the front of the paper tray.
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3. Adjust the side paper guides. It is important to adjust the 
paper guides correctly to ensure that the paper is not 
skewed in the print process. Paper jams may occur if this 
operation is not carried out correctly. 
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4. Place paper in the tray, keeping the level of the paper in 
the tray below the paper full guide arrowheads shown on 
the paper guides (1). 
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5. Replace the tray in the printer. 

Automatic feed sequence 
With no optional feed trays installed, the Autotray function in the 
Print Menu is set by default to ON and the Tray sequence function 
is set to DOWN. In this way, if a tray runs out of paper, automatic 
feed will take place in the order Tray 1, Tray 2 (if fitted), Multi 
Purpose Tray or the Manual Feed Tray, provided that these trays 
are set up for identical media. Also, configure the media size and 
media weight for the respective trays in the operator panel or 
Configuration Tool, depending on your printer model.

Note
If you have the optional second paper tray (Tray 2) 
and you are printing from the first (upper) tray (Tray 
1), you can pull out the second (lower) tray to reload 
it. However, if printing from the second (lower) tray, 
do not pull out the first (upper) tray as this will result 
in a paper jam.
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Multi purpose tray (B431)
1. Open the rear exit path (see page 59). 
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2. Pull down the Multi Purpose Tray (1), slide out the paper 
support (2), and flip open the support extension. 
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3. Load the paper into the Multi Purpose Tray and push the 
set button (4). Ensure that the paper is loaded below the 
arrow level (5) to avoid paper jam. 

• For single-sided printing on headed paper load the 
paper with the pre-printed side up and top edge into 
the printer.

Note
Do not exceed the paper capacity of approximately 50 
sheets or 10 envelopes depending on the media 
weight.
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• For two-sided (duplex) printing on headed paper, load 
the paper with the pre-printed side down and top edge 
into the printer.

• Envelopes should be loaded flap down, face up with the 
top edge to the left and short edge into the printer.

• Load Transparencies face up and top edge into the 
printer.

• For heavyweight paper or cardstock open the rear 
output cover to collect the printed output. This will give 
the paper a nearly straight path through the machine, 
avoiding paper jams and damage to the paper.

4. If required, set the media size and orientation in the media 
menu using the control panel, then issue the print 
command.

Note
Do not select Duplex printing on envelopes.

CAUTION!

Damage to the printer may occur if the incorrect 
paper setting is used when printing on a different 
media.

Note
> You can also set the media type in your printer driver. 

However, the printer driver settings will override the 
settings on the control panel or  Configuration Tool.

> Remember to reset the printer for normal paper after 
printing on a different media.
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Manual feed tray (B401/B411)
1. Open the rear exit path (see page 59). 
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Pull down the Manual Feed Tray (1), and adjust the paper 
guides (2) to the width of the paper.

Load a single sheet into the Manual Feed Tray. 

• For single-sided printing on letterhead paper, load the 
paper with the pre-printed side up and the top edge 
into the printer.

• For two-sided (duplex) printing on headed paper, load 
the paper with the pre-printed side down and top edge 
away from the printer.

• Envelopes should be loaded flap down, face up with the 
top edge to the left and short edge into the printer.

• Load Transparencies face up and top edge into the 
printer.

Note
Do not select Duplex printing on envelopes.
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If required, set the media size and orientation in the 
Configuration tool, then issue the print command.

Paper Exit Paths 

Face down exit (Default) 

• The paper exits from the top of the printer.

• For use with paper less than 28 lb.US Bond (105 g/m²)

• Capacity 150 sheets 20 lb. US Bond (75 g/m²)

CAUTION!

Damage to the printer may occur if the incorrect 
paper setting is used when printing on a different 
media.

Note
> You can also set the media type in your printer driver. 

However, the printer driver settings will override the 
settings on the control panel or Configuration Tool.

> Remember to reset the printer for normal paper after 
printing on a different media.
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• Pages printed in reading order (page 1 first; last page on top, 
facing down).

Face up exit printing   

• The paper exits from the rear of the printer. 

• Provides straight-through paper path for heavyweight stock 
(28 to 32 lb. US Bond [105-120 g/m²]). 

• Capacity 100 sheets 20 lb. US Bond (75 g/m²) 

• Pages are printed face up in reverse order.  

Important!
Make sure the rear cover is closed.

Important!
For face up printing, make sure the rear cover is open. 
In this condition, paper will exit via this path, 
regardless of driver settings.

Always use this tray in conjunction with the Manual 
Feed Tray, Multi Purpose Tray or for heavyweight 
stocks to reduce the possibility of paper jams.
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To open the rear exit: 

Setting the Paper feed, size and 
media 
The process used to fuse (fix) the printed image to the paper 
involves a mixture of pressure and heat. Too much heat will 
cause lightweight paper to crease or curl and corrugations in 
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transparencies. Too little heat will cause the image not to fuse 
fully into heavyweight paper.

B401/B411 
You can change the media size, type and weight as follows:

1. Start the Configuration Tool. (Click on Start > All 
Programs > Okidata > Configuration Tool and select 
the Configuration Tool.)

2. Click the B401/B411 icon in the left panel 

3. Click the Device Settings tab.

4. Click the Menu Setting button.

5. Click USER MENU.

6. Click MEDIA MENU.

7. Make your changes in the drop down boxes, then click the 

Save current details icon ( ).

Note
Although media properties can be set in the printer 
driver for particular jobs, when filling a tray with 
media it is recommended that you manually set the 
printer to match the media as described here.
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B431
Using the control panel on your B431 printer, you can choose:

• which paper to use

• the size of the paper you wish to use

• the weight of the paper (thickness)

• the type of paper

Paper feed selection

The paper feed, paper size, paper weight and media type can be 
set manually on the printer using the control panel as follows.

1. Press the Menu ▲ or ▼ button repeatedly until PRINT 
MENU is displayed, then press the OK button.

2. Press the ▲ or ▼ button until the required paper feed is 
displayed.

3. Press the OK button. An asterisk (*) appears next to the 
selected paper feed.

4. Press the Cancel or Online or the Back button repeatedly 
to exit the MENU mode.

Note
> If the settings in the printer differ from those selected 

on your computer, the printer will not print and the LCD 
will display an error message.

> The following printer settings are given as a guide only. 
Some software applications require the paper feed, size 
and media settings to be selected from within the 
application (page setup).

> Although media properties can be set in the printer 
driver for particular jobs, it is recommended that when 
filling a tray with media you manually set the printer to 
match the media as described here.

Note
When the AUTO TRAY SWITCH is set to ON and more 
than one paper tray is fitted, paper feed automatically 
switches to the next available paper tray, providing 
non-stop printing.
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Paper size

Set the paper size as follows.

1. Press the Menu ▲ or ▼ button until PRINT MENU is 
displayed, then press the OK button.

2. Press either the ▲ or ▼ button repeatedly until EDIT SIZE 
is displayed, then press Enter button.

3. Press either ▲ or ▼ button until the required paper size is 
displayed, then press the OK button. An asterisk (*) 
appears next to the selected paper size.

4. Press the Cancel or Online or the Back button repeatedly 
to exit the MENU mode.

5. Select the correct paper settings in the printer driver 
before printing the file.

Media type and weight

Set media type and weight as follows:

1. Press the Menu ▲ or ▼ button until MEDIA MENU is 
displayed, then press the OK button.

2. Press the ▲ or ▼ button until MEDIA TYPE or MEDIA WEIGHT 
for the required tray is displayed, then press OK button.

3. Press the ▲ or ▼ button until the required paper type or 
weight is displayed, then press the OK button. An asterisk 
(*) appears next to the selected paper type or weight.

Note
> When using paper trays, standard paper sizes are 

recognized automatically with CASSETTE SIZE (default 
setting) selected. Paper size need only be set for 
custom paper sizes.

> When using the Multi Purpose Tray, the paper size has 
to be selected.

CAUTION!

If media type or media weight are not correctly set, 
print quality deteriorates and the fuser roller may 
be damaged.
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4. Press the Cancel or Online or the Back button repeatedly 
to exit the MENU mode.

5. Select the correct paper settings in the printer driver 
before printing the file.
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Interfaces
Your printer is equipped with a selection of data interfaces:

1. Parallel – For direct connection to a PC. This port requires 
a bi-directional (IEEE 1284 compliant) parallel cable.

2. USB – For connection to a PC running Windows 2000 or 
later or Mac OS X or later. This port requires a cable 
conforming to USB version 2.0 or above.

The operation of a printer is not assured if a USB 
compatible device is connected concurrently with other 
USB-compatible machines.

When connecting multiple printers of the same type, they 
appear as *****, ***** (2), ***** (3), etc. These 
numbers depend on the order of connecting or turning on 
each printer.

3. LAN – For network cable connection. This port is standard 
on the B401dn/B411dn and B431dn.

If you are connecting your printer directly to a stand alone 
computer proceed to the chapter entitled “Printer Drivers”.

If your printer is to be installed as a network printer, please refer 
to the relevant section in the User’s Guide for the network 
interface card for further details on how to configure the network 
connection before installing the printer drivers.

Note
> It is not recommended that you connect serial/USB and 

parallel cables to the printer simultaneously.

> Interface cables are not supplied with your printer.

Note
Administrator’s authority is required when installing a 
network connection.
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Printer Drivers
The printer drivers are all contained on the CD-ROM supplied with 
your printer. 

See the Setup Guide for information on installing the drivers and 
utilities for your printer.

Please refer to the readme file on this CD for the latest 
information on printer driver installation.



Operation
This chapter provides a broad outline of how to operate your 
printer from either a Windows or a Macintosh environment. In 
the former, while PCL emulation is available on all printer models, 
PS emulation is available on the B431 models.

Printer settings in Windows

The operator panel controlled menus and Configuration Tool 
(described in the chapter entitled “Operator panels”) provide 
access to many options.

The Windows printer driver also contains settings for many of 
these items. Where items in the printer driver are the same as 
those in the operator panel and Configuration Tool menus, and 
you print documents from Windows, the settings in the Windows 
printer driver will override those settings in the operator panel 
and Configuration Tool menus.

Printing preferences in Windows 
applications
When you choose to print your document from a Windows 
application program a Print dialogue box appears. This dialogue 
usually specifies the name of the printer on which you will print 
your document. Next to the printer name is a Properties button.

When you click Properties a new window opens which contains 
a short list of the printer settings available in the driver, which 
you can choose for this document. The settings available from 
within your application are only those which you may want to 
change for specific applications or documents. Settings you 
change here will usually only last for as long as the particular 
application program is running.

Note   
The illustrations in this guide relate to Windows XP 
PCL and PS emulations – other operating system 
windows may appear slightly different but the 
principles are the same.
67 > B401/B411/B431



PCL emulation
The tabs available are the Setup Tab, the Job Options Tab and 
the Image Tab.

Setup tab

1. Paper size should be the same as the page size of your 
document (unless you wish to scale the printout to fit 
another size), and should also be the same as the size of 
paper you will feed into the printer.

2. You can choose the source of the paper to feed, which may 
be Tray 1 (the standard paper tray), Manual Feed Tray 
(B401/B411), Tray 2 (B411/B431 only) (if you have the 
optional second paper tray installed) or the Multi Purpose 
Tray (B431). You can also click on the appropriate part of 
the screen graphic to select your preferred tray.

3. A variety of document finishing options can be selected, 
such as normal one page per sheet, or N-up (where N can 
be 2 or 4) for printing scaled down pages at more than one 
page per sheet.
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4. Under 2-sided Printing, you can choose from auto (16-28 
lb US Bond [60-105 g/m²]) or manual (up to 32 lb. US 
Bond [124 g/m²]). 
Under manual 2-sided Printing choose 2-sided printing 
(duplex printing) to carry out manual duplex printing. You 
must pass the paper through the printer twice. For more 
information, see “2-Sided (Duplex) Printing” on page 82. 
The Duplex Help button also offers guidelines on how to 
carry out manual duplex printing.

5. If you have changed some printing preferences before and 
saved them as a set, you can recall them to avoid havin.

• The High Quality setting prints at 600 x 2400 dpi or 600 
x 1200 dpi for the B401/B411, and 1200 x 1200 dpi for 
the B431 and is the best option for printing vector 
objects such as graphics and text. 

• The Normal setting prints at 600 x 600 dpi and is 
suitable for most printing jobs.

• The Draft setting prints at 300 x 300 dpi and is suitable 
for printing draft documents that contain mainly text. 

• You can select Toner Saving to save toner for some 
print jobs.
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6. Page orientation can be set to either portrait (tall) or 
landscape (wide). Both views can be rotated by 180 
degrees. 

7. You can print watermark text behind the main page image. 
This is useful for marking documents as draft, confidential, 
etc.

If you would like to print on special stationery, such as 
forms and letterhead, but do not want to use pre-printed 
stationery, you can create your own using Overlays (for 
B431). For more information on Overlays and Macros refer 
to page 106. The Overlays button also offers guidelines on 
how to carry out manual duplex printing.

8. In Raster (bitmap) mode, processing of the page image is 
done in the computer leaving little processing for the 
printer to do, although the file size may be large.
In Vector mode, file sizes may be smaller and so 
transmission over a network, for example, may be faster.
These effects are more pronounced for graphics printing 
than for text printing.

9. You can select up to 999 copies to print consecutively, 
although you will need to top up the paper tray during 
such a long print run.

10. Your printed pages can be scaled to fit larger or smaller 
stationery, within a range of 25% to 400% of the original 
size.

11. A single on-screen button restores the default settings.
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Image tab

1. Dithering produces an intermediate greyscale by adjusting 
the combination of dots used in printing. Selecting a 
setting determines the degree of detail with which a 
graphics image will be printed. Mesh determines that a 
screen of dots is used for dithering while Line Art 
determines that an array of lines is used for dithering.

2. Select dithering texture by setting the size of dots used in 
the halftone screen.

3. Set this control to print greyscale effects in black without 
dithering. Select the check-box to disable greyscale 
printing or de-select the check-box to enable greyscale 
printing.

4. You can manually adjust lightness (the higher the setting 
the lighter the print) and contrast (the higher the setting 
the greater the contrast).

5. A single on-screen button restores the default settings.

PS emulation (B431)
The tabs available are the Layout Tab, the Paper/Quality Tab 
and the Job Options Tab.
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Layout tab 

1. Page orientation can be set to portrait (tall), landscape 
(wide) or landscape rotated by 180 degrees.

2. Print on both sides (duplex printing) can be set to long 
edge or shirt edge of the document.

3. Printed page order can be set s front to back or back to 
front of the document.

4. Set the number of pages to be p0rinted on a single sheet. 
You can also set it to print a booklet.
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5. Click the Advanced button to be able to set further 
document options as follows:

1. Select the required printed paper size.

2. You can substitute another font for TrueType Font.

3. You can set other document options as required, including 
PostScript options and printer features.
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Paper/Quality tab

You can set the paper source or leave it as automatic selection 
and by using the Advanced button you have access to the same 
set of options as described above for the Layout Tab.
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Job options tab

1. The output resolution of the printed page can be set as 
follows.

• The High Quality setting prints at 600 x 2400 dpi  or 
600 x 1200 dpi for B401/B411, and 1200 x 1200 dpi for 
B431 and is the best option for printing vector objects 
such as graphics and text.

• The Normal setting prints at 600 x 600 dpi and is 
suitable for most printing jobs. 

• You can select Toner Saving to save toner for some 
print jobs.
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2. You can print watermark text behind the main page image. 
This is useful for marking documents as draft, confidential, 
etc.

If you would like to print on special stationery, such as 
forms and letterhead, but do not want to use pre-printed 
stationery, you can create your own using Overlays (for 
B431). For more information see page 106. The Overlays 
button also offers guidelines on how to carry out manual 
duplex printing.

3. You can select up to 999 copies to print consecutively, 
although you will need to top up the paper tray during 
such a long print run.

4. Your printed pages can be scaled to fit larger or smaller 
stationery.

5. Using the Advanced button gives you access to the 
facility to set mirror image printing and negative image 
printing.

6. A single on-screen button restores the default settings.

Setting from Windows control panel
When you open the driver properties window directly from 
Windows, rather than from within an application program, a 
somewhat more extensive range of settings is provided. Changes 
made here will generally affect all documents you print from 
Windows applications, and will be remembered from one 
Windows session to the next.

PCL emulation

The main tabs are the General Tab, Advanced Tab and Device 
Options Tab.
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General tab

1. This area lists some of the main features of your printer, 
including optional items.

2. This button opens the same windows as described earlier 
for items which can be set from within application 
programs. Changes you make here, however, will become 
the new default settings for all Windows applications.

3. This button prints a test page to ensure that your printer is 
working.

Note
The above features are provided by the Windows XP 
operating system and will vary with other operating 
systems.
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Advanced tab

1. You can specify which times of day your printer will be 
available.

2. Indicates current priority, from 1 (lowest) to 99 (highest). 
Highest priority documents will print first.

3. Specifies that documents should be spooled (stored in a 
special print file) before being printed. The document is 
then printed in the background, allowing your application 
program to become available more quickly. Options follow:

This specifies that printing should not start until the last 
page has been spooled. If your application program needs 
a lot of time for further computation in the middle of 
printing, causing the print job to pause for more than a 
short period, the printer could prematurely assume that the 
document has finished. Selecting this option would prevent 
that situation, but printing will be completed a little later, 
as the start is delayed.

This is the opposite choice to the one above. Printing starts 
as soon as possible after the document begins spooling.

4. This specifies that the document should not be spooled, 
but printed directly. Your application will not normally be 
ready for further use until the print job is complete. This 
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requires less disk space on your computer, since there is 
no spool file.

5. Directs the spooler to check the document setup and 
match it to the printer setup before sending the document 
to print. If a mismatch is detected, the document is held in 
the print queue and does not print until the printer setup is 
changed and the document restarted from the print queue. 
Mismatched documents in the queue will not prevent 
correctly matched documents from printing.

6. Specifies that the spooler should favour documents which 
have completed spooling when deciding which document 
to print next, even if completed documents are lower 
priority than documents which are still spooling. If no 
documents have completed spooling, the spooler will 
favour larger spooling documents over shorter ones. Use 
this option if you want to maximize printer efficiency. 
When this option is disabled the spooler chooses 
documents based only on their priority settings.

7. Specifies that the spooler should not delete documents 
after they are completed. This allows documents to be re 
submitted to the printer from the spooler instead of 
printing again from the application program. If you use 
this option frequently it will require large amounts of disk 
space on your computer.

8. Specifies whether advanced features, such as pages per 
sheet, are available, depending on your printer. For normal 
printing keep this option enabled. If compatibility 
problems occur you can disable the feature. However, 
these advanced options may then not be available, even 
though the hardware might support them.

9. This button provides access to the same setup windows as 
when printing from applications. Changes made via the 
Windows Control Panel become the Windows default 
settings.

10. You can design and specify a separator page that prints 
between documents. This is particularly useful on a shared 
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printer to help each user find their own documents in the 
output stack.

Device options tab

In this window you can select which optional upgrades are 
installed on your printer. See the chapter entitled “Installing 
options”.

PS emulation 

The main tabs are the General Tab, Advanced Tab and Device 
Settings Tab. The General and Advanced tabs are the same as 
for PCL emulation described earlier.

Note
The above features are provided by the Windows XP 
operating system and will vary with other operating 
systems.
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Device settings tab

1. You can set the desired paper sizes in each of the available 
paper feed trays.

2. You can make a variety of font settings depending on your 
application.

3. You can set which optional upgrades are installed on your 
printer. See the chapter entitled “Installing options”. 

Printer settings in Macintosh
Refer to the readme file on the driver CD and the online help 
provided in the driver software.
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2-Sided (Duplex) Printing 
The built-in duplex unit adds the function of two-sided printing, 
using less paper and making large documents easier to handle. 
It also enables booklet printing, which uses even less paper.

This printer has the option of Auto Duplex and Manual Duplex 
printing.

Auto versus Manual Duplex 
Printing 
Auto duplex printing uses the printer’s built-in duplex unit to 
automatically print on both sides of a sheet of paper. 

To carry out Manual Duplex Printing, you must pass paper 
through the printer twice.

Auto Duplexing: Models B401/B411 and 
B431
• Use Tray 1 or optional Tray 2*.

* B411/B431 only

• Usable paper sizes: letter and A4.

• Usable paper weight: 16 to 28 lb. US Bond (60 to 104 g/m²).

Note
The steps in the process relate to Windows XP PCL. 
Other operating system windows may appear slightly 
different, but the principles are the same.

Note
Manual Duplex printing is available only for the 
Windows PCL Driver. 
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Manual duplexing: Model B401/B411
• Use Tray 1, optional Tray 2*, Manual feed tray (one sheet at a 

time). 
* B411/B431 only

• Usable paper sizes: 

- letter, Executive, Legal 13, Legal 14, Statement (5.5 x 
8.5'') 

- A4, A5, B5, A6 

- Custom: width 3.5 to 8.5 inches (90 – 216 mm), length 
5.8 to 14 inches (148 – 356 mm)

• Usable paper weight: 16 to 32 lb. US Bond (120 g/m²)

Manual duplexing: Model B431
• Use Tray 1, optional Tray 2, Multi-purpose tray (up to 100 

sheets 20 lb. US Bond (75 g/m²). 

• Usable paper sizes: 

- letter, Executive, Legal 13, Legal 14, Statement (5.5 x 
8.5'') 

- A4, A5, B5, A6 

- Custom: width 3.5 to 8.5 inches (90 – 216 mm), length 
5.8 to 14 inches (148 – 356 mm)

• Usable paper weight: 16 to 32 lb. US Bond (120 g/m²) 

Duplex printing
1. Select File > Print and click the Properties button. 

2. Select the input tray from the Source drop down.

3. In the 2-Sided Printing drop down menu, select either 
Long Edge (Auto) or Short Edge (Auto) according to 
your printing preferences. 
83 > B401/B411/B431



4. If you require further information, click the duplex help 
button. 

5. Click the Print button.
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Consumables and 
Maintenance

This section deals with the replacement of the toner cartridge and 
image drum and general maintenance.

Consumable order details

Please always use genuine consumables. 

Toner cartridge life
How long your toner cartridge lasts depends on the print density; 
at ISO/IEC 19752 print density print pattern, a standard toner 
cartridge will print an average of 1,500 pages (B401) or 4,000 
pages (B411/B431). Remember, this is only an average: actual 
results may vary.

The first toner cartridge installed in a new printer has to fill the 
image drum reservoir and saturate the developing roller with 
toner. The toner cartridge that is supplied with this printer 
normally produces about 1,000 pages (B401) or 2,000 pages 
(B411/B431) after installation.

When to replace the toner 
cartridge
When the toner is running low, TONER LOW is displayed in the 
operator panel LCD. After Toner Low displays, the printer will 

ITEM FOR MODEL ORDER NO.

Toner, 1.5K B401 44992405

Image drum, 25K B401 44574309

Toner, 4K B401, B411, 
B431

44574701 

Toner, 10K B431 44574901

Image drum B401, B411, 
B431

44574301
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print about 100 more pages then display Toner Empty and stop 
printing. Printing will resume after a new toner cartridge has 
been installed.

Replacing the toner cartridge

It is recommended that you clean the LED array at the same time 
as you change the toner cartridge.

The toner used in this printer is a very fine dry powder contained 
in the toner cartridge.

Have a sheet of paper handy so that you have somewhere to 
place the used cartridge while you install the new one.

Dispose of the old cartridge responsibly, inside the pack that the 
new one came in. Follow any regulations, recommendations, 
etc., which may be in force concerning waste recycling.

If you do spill any toner powder, lightly brush it off. If this is not 
enough, use a cool, damp cloth to remove any residue. Do not 
use hot water, and never use solvents of any kind. They will 
make toner stains permanent.

WARNING

> Never expose a toner cartridge to an open flame. 
It can cause an explosion and you can be 
burned.

> Be sure to switch off and unplug the machine 
before accessing the interior of a machine for 
cleaning, maintenance or fault clearance. Access 
to a live machine’s interior can cause electric 
shock.

WARNING!

If you inhale any toner, go to fresh air and seek 
medical attention.
If you get toner in your eyes, bathe your eyes 
liberally in cold water. Seek medical attention 
immediately.
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1. Switch off the printer and allow the fuser to cool for about 
10 minutes before opening the top cover.

2. Press the top cover release button and open the printer’s 
top cover fully. 

WARNING!

If the printer has been powered on, the fuser may 
be hot. This area is clearly labelled. Do not touch.

Note
The B431 model has been illustrated below. The 
principles are the same for the B401/B411.
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3. Pull the colored lever (1) on the right side of the toner 
cartridge towards the front of the printer to close the 
cartridge then remove the used toner cartridge (2).

4. Clean the top of the ID unit (3) with a clean, lint free cloth.

5. Put the cartridge down gently onto a piece of paper to 
prevent toner from marking your furniture.

6. Remove the new cartridge from its box but leave its 
wrapping material in place for the moment.
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7. Gently shake the cartridge from end to end several times 
to loosen and distribute the toner evenly inside the 
cartridge.

8. Remove the wrapping material and peel off the adhesive 
tape from the underside of the cartridge. 

9. Holding the cartridge by its top center with the colored 
lever to the right, lower it into the printer over the image 
drum unit from which the old cartridge was removed.
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10. Insert the left end of the cartridge into the image drum 
unit. Align it against the pins (1) on the drum unit. Then 
lower the right end of the cartridge down into the image 
drum unit (2).
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11. Pressing gently down on the cartridge to ensure that it is 
firmly seated, push the colored lever (1) towards the rear 
of the printer. This will lock the cartridge into place and 
release toner into the image drum unit.
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12. Gently wipe the LED array surface with a soft tissue.

13. Lower the top cover and press it down to latch it closed. 
92 > B401/B411/B431



Image drum life
The life of an image drum depends on a number of factors, 
including temperature and humidity, the type of paper used, and 
the number of pages per job. The image drum should last 
approximately 25,000 pages when printing 3 pages per job 
(B401) or 30,000 pages when printing 3 pages per job (B411/
B431). This number is approximate because different numbers of 
pages are printed each time and the environmental conditions 
and the paper type used may vary.

When to replace the image drum
When the drum reaches 90% of its life, a REPLACE IMAGE DRUM 
message is displayed in the operator panel LCD. Change the 
image drum when the print becomes faint or begins to 
deteriorate.

Replacing the image drum.

WARNING

> Never expose the image drum to an open flame. 
It can cause an explosion and you can be 
burned.

> Be sure to switch off and unplug the machine 
before accessing the interior of a machine for 
cleaning, maintenance or fault clearance. Access 
to a live machine’s interior can cause electric 
shock.

NOTE
> It is recommended that you change the toner cartridge 

and clean the LED array at the same time as you 
change the image drum.

> The B431 model has been illustrated below. The 
principles are the same for the B401/B411 printer.
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1. Press the cover release and open the printer’s top cover 
fully. 

WARNING!

If the printer has been powered on, the fuser may 
be hot. This area is clearly labelled. Do not touch.
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2. Holding it by its top centre, remove the used image drum 
and toner cartridge, out of the printer.

3. Put the assembly down gently onto a piece of paper to 
prevent toner from marking your furniture and to avoid 
damaging the green drum surface.

CAUTION!

The green image drum surface at the base of the ID 
unit is very delicate and light sensitive. Do not touch 
it and do not expose it to normal room light for more 
than 5 minutes. If the drum unit needs to be out of 
the printer for longer than this, please wrap the 
cartridge inside a black plastic bag to keep it away 
from light. Never expose the drum to direct sunlight 
or very bright room lighting. 
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4. With the colored toner release lever (1) to the right, pull 
the lever towards you. This will release the bond between 
the toner cartridge and the image drum unit. 

5. Lift the right-hand end of the toner cartridge and then 
draw the cartridge to the right to release the left-hand 
end, and withdraw the toner cartridge out of the image 
drum cartridge. Place the cartridge on a piece of paper to 
avoid marking your furniture.

6. Take the new image drum cartridge out of its packaging 
and place it on the piece of paper where the old cartridge 
was placed. Keep it the same way round as the old unit. 
Pack the old cartridge inside the packaging material for 
disposal.

7. Place the toner cartridge onto the new image drum 
cartridge. Push the left end in first, and then lower the 
right end in. 

Note
Follow instructions that come with the new image 
drum for additional information such as the removal 
of packaging material etc.
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8. Push the colored release lever (1) away from you to lock 
the toner cartridge onto the new image drum unit and 
release toner into it. 
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9. Holding the complete assembly by its top center, lower it 
into place in the printer locating the pegs (1) at each end 
into their slots in the sides of the printer cavity (2).
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10. Gently wipe the LED array surface with a soft tissue. 

11. Lower the top cover and press it down to latch it closed. 
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Generating a cleaning page
If the printed page shows signs of fading, streaking or erratic 
marks, the problem may be cleared by generating a drum 
cleaning page as follows.

B401/B411
1. Press the Online button to take the printer OFF LINE.

2. Open the Manual Feed Tray and insert a sheet of Letter/A4 
plain paper between the paper guides. For loading paper, 
see page 52. 

3. Press and hold down the Online button for at least seven 
seconds.

4. The printer prints a cleaning page.

5. Return the printer ONLINE by pressing the Online button.

6. If subsequent printing appears faded or uneven, try 
replacing the toner cartridge.
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B431
1. Pull down the Multi Purpose Tray (1), slide out the paper 

support (2), and flip open the support extension (3). 
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2. Adjust the paper guides to the width of the paper. 

3. Insert a sheet of Letter/A4 plain paper between the paper 
guides and push the colored set button to engage the tray. 

4. Press the Menu ▲ or ▼ button repeatedly until 
MAINTENANCE MENU is displayed, then press the OK button.

5. Press the ▲ or ▼ button until CLEANING PRINT is 
displayed.
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6. Press the OK button.

7. The printer prints a cleaning page.

8. Press Cancel or Online or the Back button repeatedly to 
exit the Menu mode. The printer should now be ON LINE. 

9. If subsequent printing appears faded or uneven, try 
replacing the toner cartridge.
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Cleaning the LED array
Clean the LED array whenever a new toner cartridge is installed 
or if there are faded vertical areas or light printing down a page.

1. Switch off the printer and allow the fuser to cool for about 
10 minutes before opening the top cover.

2. Press the top cover release button and open the printer’s 
top cover fully.

WARNING!

If the printer has been powered on, the fuser may 
be hot. This area is clearly labelled. Do not touch.
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3. Wipe the LED array gently with a soft tissue.

4. Lower the top cover and press it down to latch it closed. 
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Overlays and Macros 
(Windows Only)

What are overlays and macros?
If you would like to print on special stationery, such as forms and 
letterhead, but do not want to use pre-printed stationery, you 
can create your own using these advanced features.

You can use PostScript overlays to generate all your special 
stationery and store it in the printer for use whenever you need 
it. If you have chosen to install the PCL driver, macros perform a 
similar function.

You can create several overlays or macros, and combine them in 
any way you like to produce a variety of forms and other special 
stationery. Each image can be printed on just the first page of a 
document, on all pages, on alternate pages, or just the pages 
that you specify.

Creating PostScript overlays
Three steps are required to create an overlay:

1. Create the form data using your own application software 
and print it to a printer (.PRN) file.

2. Use the Storage Device Manager utility software supplied 
on CD with your printer to create a “project file,” import 
the.PRN file(s), and download the generated filter (.HST) 
file to the printer. The project file will contain one or more 
overlay images which are functionally related, such as the 
cover page and the continuation page images for business 
letters.

3. Use downloaded files to define your overlays ready for use 
when printing your documents.

When printing overlay files to disk, do not select any special 
features, such as two-sided printing or multiple copies. These are 
not appropriate to overlays, they apply only to your final 
documents.
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Creating the overlay image
1. Use your preferred application, perhaps a graphics 

program, to create the required overlay image and save it.

2. Open your application’s 
Print… dialogue.

3. Make sure that the 
selected printer 
name (1) is that of your 
PostScript printer driver.

4. Select the Print To 
File (2) option.

5. Click the Properties button (3) to open the Document 
Properties window.

6. On the Overlay tab, choose 
Create Form from the drop-
down list (4).

7. Click OK to close the 
Document Properties 
window.

8. Click OK again to close the 
Print dialogue.

9. When prompted for a print 
file name, enter a meaningful name with the 
extension.PRN.

10. Close your application.

Create and download the project
1. From the Windows Start menu, start Storage Device 

Manager (SDM) and allow SDM to discover the printer.

2. Choose Projects→New Project.

3. Choose Projects > Add File to Project.

4. Set the Files of Type drop-down list to PRN 
Files(*.prn).

5. Navigate to the folder where the.PRN files are stored and 
select one or more of these to include in your overlay set.
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You can have more than one printer (.PRN) file in a project. 
For example, one for top pages and another for 
continuation pages. Use standard Windows techniques 
(Shift or Ctrl keys) to select multiple files simultaneously if 
you need to.

6. Click Open to add these files to the current project.

7. When a message box appears confirming that a filter file 
has been created, click OK to clear the message.

8. The project window will display one.HST file for each 
printer file added. Make a careful note of each of these 
names. Ensure that you note them exactly as they appear, 
they are case sensitive, and you will need them later.

9. Choose Projects > Save Project and enter a meaningful 
name (e.g. “Letter Stationery”) so that you can recognize 
it later if you want to modify it.

10. Choose Projects > Send Project Files to Printer to 
download the project to the printer.

If you have a hard disk in the printer, SDM will 
automatically download files to it. If not, SDM will download 
files to flash memory. If you have a hard disk but still prefer 
to download to flash memory, double-click the file name in 
the Project window and under Volume, type in 
%Flash0% and then click OK.

11. When the message “Command Issued” appears confirming 
that the download is complete, click OK to clear the 
message.

Test printing the overlay
1. Click on the printer icon for the relevant printer and 

choose Printers > Test Form.

2. In the Test PostScript Form window, to test each overlay 
select it and click OK. There will be a short pause while the 
printer processes the form, and then it will print.

3. When each overlay has been tested, click Exit.

4. Click the standard Windows Close (X) button, or choose 
Projects > Exit to close Storage Device Manager.
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Defining overlays
This is the final step before the new overlays are ready for use.

1. Open the Printers (called “Printers and Faxes” in 
Windows XP) window via the Start menu or the Windows 
Control Panel.

2. Right-click on the Relevant PostScript printer icon and 
choose Printing Preferences from the pop-up menu.

3. On the Overlay tab, click the New button.

4. In the Define Overlays window, 
enter a suitable name (2) for this 
overlay and choose which 
page(s) (3) of your documents 
will use this overlay.

5. Enter the name of the overlay 
file (4) exactly as it appeared in 
the Storage Device Manager 
project window. Remember that 
this name is case sensitive.

If you forgot to note the overlay names when you created 
them, you can find them using Storage Device Manager to 
view the project file, or the printer’s Information Menu to 
print a file list and identify them from there.

6. Click Add (5) to add this overlay into the defined overlays 
list.

7. Click OK to close the Define Overlay window.

The new overlay now appears in the Defined Overlays list 
in the printer properties window.

8. Repeat the above procedure if you wish to define more 
overlays.

9. When done, click OK to close the printer properties 
window.

Your new overlays are now ready and available to be used for any 
future documents you wish.
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Printing with PostScript overlays
Once you have defined your overlays you are ready to use them 
for any documents you wish. The example illustrated here uses 
two overlays for business letters. The first prints on just the top 
page, and the second prints on any or all subsequent pages.

1. Prepare your document in the normal way using your own 
application software. Remember, if necessary, to format 
the document so that it will fit within the appropriate 
space.

2. Open your application’s Print… dialogue and choose any 
options you will require, ensuring that the target printer is 
your PostScript printer driver in which the overlays have 
been defined.

3. Click the Properties button to open the Printing 
Preferences window.

4. On the Overlays tab, choose 
Use Overlay from the drop-
down list (1).

5. Click on the first overlay (2) 
you wish to use. In this 
example it is the Cover Page 
overlay. Then click the Add 
button (3).

6. If you want to use another 
overlay, in this case it is the 
Continuation page, click the second overlay (4) and then 
click the Add button (3) again.

7. When you have selected all the overlays you want to use 
for this document, click OK.

8. Finally, in your application’s print dialogue, click OK to 
begin printing.

1

3
2

4
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Creating PCL Overlays
Three steps are required to create an overlay:

1. Create the form data using your own application software 
and print it to a printer (.PRN) file.

2. Use the Storage Device Manager utility software supplied 
on CD with your printer to create a “project file,” import 
the .PRN file, and download the generated filter (.BIN) files 
to the printer.

3. Use downloaded files to define your overlay ready for use 
with any future document.

When printing files to disk, do not select any special 
features, such as two-sided printing or multiple copies. 
These are not appropriate to macros, they apply only to 
your final documents.

Creating the overlay image
1. Use your preferred application, perhaps a graphics 

program, to create the required image and save it.

2. Open your application’s 
Print… dialogue.

3. Make sure that the selected 
printer name (1) is that of 
your PCL printer driver.

4. Select the Print To File (2) 
option.

5. When prompted for a print 
file name, enter a meaningful name with the extension 
.PRN .

6. Close your application.

Create and download macros
1. From the Windows Start menu, start Storage Device 

Manager (SDM) and allow SDM to discover the printer.

2. Choose Projects > New Project to start a new project.

1 3

2
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3. Choose Projects > Filter Macro File. The Filter Printer 
Patterns dialogue box appears. Make any adjustments in 
the settings that you need and then click OK.

Example: If you create a black oval in MS Paint and leave 
all the color command filters checked, the black oval will 
print as a black rectangle when the overlay is used. To 
maintain the oval shape, turn off (deselect) the “Configure 
Image Data,” “Palette ID” and “Palette Control” filters.

4. Set the Files of Type drop-down list to PRN 
Files(*.prn).

5. Navigate to the folder where the overlay .PRN files are 
stored and select one or more of these to include in your 
overlay set.

You can have more than one macro file in a project. For 
example, one for top pages and another for continuation 
pages. Use standard Windows techniques (Shift or Ctrl 
keys) to select multiple files simultaneously if you need to.

6. Click Open to add these files to the current project. (You 
can also drag and drop files from Windows Explorer 
directly into the project window if you prefer.) When a 
message box appears confirming that a filter file has been 
created, click OK to clear the message.

7. The project window will display one .BIN file for each 
printer file added. Make a careful note of the name and ID 
number for each of the files. You will need them later.

If you wish to edit the names or ID numbers, double-click 
the file entry and edit the details. 

Note that the names are case sensitive. 

8. Choose Projects > Save Project and enter a meaningful 
name (e.g. “Letter Stationery”) so that you can recognize 
it.

9. Choose Projects > Send Project Files to Printer to 
download the project to the printer.

10. When the message “Command Issued” appears confirming 
that the download is complete, click OK to clear the 
message.
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Test printing the macro
1. Choose Printers > Test Macro.

2. In the Test Macro window, enter its ID number and click 
OK. After a short pause the printer will print the macro.

3. When each macro has been tested, click Exit.

4. Click the standard Windows Close (X) button, or choose 
Projects→ > Exit to close Storage Device Manager.

Defining overlays
This is the final step before the new overlays are ready for use.

1. Open the Printers (called “Printers and Faxes” in 
Windows XP) window via the Start menu or the Windows 
Control Panel.

2. Right-click on the Relevant PostScript printer icon and 
choose Printing Preferences from the pop-up menu.

3. On the Job Options tab, click the Overlay button.

4. In the Overlay window, Click the 
Define Overlays button (1).

5. In the Define Overlays window, 
enter the name (a) and ID (b) of 
the required overlay, and define 
which page(s) (c) of your 
documents will use this overlay. 
Then click the Add button (3) to 
add this overlay to the list of 
defined overlays. Repeat for any 
other related overlays. When 
done, click the Close button (4) 
to close the window.

1

a

3

b

4

c
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The example illustrated shows two overlays defined, one 
for a cover page and one for continuation pages.

Remember that names and IDs of overlay files must be 
entered exactly as they appeared in the Storage Device 
Manager project window. Remember also that names are 
case sensitive.

If you forgot to note the overlay name or ID when you 
created them, you can find them using Storage Device 
Manager to view the project file, or the printer’s 
Information Menu to print a file list and identify them from 
there.

The new overlays will now appear in the Defined Overlays 
list in the printer properties window.

6. When done, click OK to close the printing preferences 
window.

Your new overlays are now ready and available to be used for any 
future documents you wish.

Printing with PCL overlays
Once you have defined your overlays you are ready to use them 
for any documents you wish. The example illustrated here uses 
two overlays for business letters. The first prints on just the top 
page, and the second prints on any or all subsequent pages.

1. Prepare your document in the normal way using your own 
application software. Remember, if necessary, to format 
the document so that it will fit nicely within the plain areas 
on your letterhead overlay.

2. Open your application’s Print… dialogue and choose any 
options you will require, ensuring that the target printer is 
your PCL printer driver in which the overlays have been 
defined.

3. Click the Properties button to open the Printing 
Preferences window.
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4. On the Overlay tab, check the 
Use active overlays 
checkbox (1).

5. In the Defined Overlays list, 
click on the first overlay (2) you 
wish to use, and click the Add 
button (3) to add it to the 
Active Overlays list. (If you 
want a reminder of how this 
overlay looks, click the Test 
Print button.)

6. If you want to use another overlay with this document, in 
this example it is the “Continuation Page” overlay, click 
this overlay (4) in the list of defined overlays, and then 
click the Add button (3) again to add the second overlay 
to the list of active overlays.

7. When the list of active overlays contains all the items you 
want to use, click OK.

8. Finally, click the Print button in your application’s Print 
dialogue to begin printing your document.

1

3

4
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Troubleshooting

Status and error messages
Your printer has been designed to give you helpful status 
feedback not only during normal operation but also if a printing 
problem occurs so that you can take appropriate corrective 
action.

The LCD on the printer operator panel provides the self-
explanatory status and error messages in your chosen language. 
Error messages are accompanied by the Ready indicator being 
extinguished.

Paper Jams
Provided that you follow the recommendations in this guide on 
use of print media, and you keep the media in good condition 
prior to use, your printer should give years of reliable service. 
However, paper jams occasionally do occur, and this section 
explains how to clear them quickly and simply.

Jams can occur due to paper mis feeding from a paper tray or at 
any point on the paper path through the printer. When a jam 
occurs, the printer immediately stops, and the operator panel 
informs you of the event. If printing multiple pages (or copies), 
do not assume that having cleared an obvious sheet that others 
will not also be stopped somewhere along the path. These must 
also be removed in order to clear the jam fully and restore normal 
operation.
116 > B401/B411/B431



The printer may experience a paper jam in one of three areas. 

1. INPUT JAM - paper has failed to leave the selected feed 
tray and enter the internal paper path of the printer. A 
typical message indicates a paper jam and identifies the 
tray to check.

2. FEED JAM - paper has entered the printer but failed to 
reach the exit. A typical message indicates a paper jam 
and advises you to open the top cover for access.

3. EXIT JAM - paper has reached the exit but has failed to 
exit completely from the printer. A typical message 
indicates an exit jam and advises you to open the top 
cover for access.
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Input jam
1. Remove the paper tray from the printer. Remove any 

crumpled or folded paper. remove any paper from the 
underside of the printer.

2. Replace the paper tray. 

After successful removal of any damaged or misfed paper, the 
printer should continue printing.

Feed jam or exit jam
1. Remove the tray and clear any misfed sheets as given 

above.
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2. Press the cover release and open the printer’s top cover.    

WARNING!

If the printer has been powered on, the fuser area 
will be hot. This area is clearly marked. Do not touch 
it.

CAUTION!

Never expose the image drum unit to light for more 
than 5 minutes. Never expose the image drum unit 
to direct sunlight. Always hold the image drum unit 
by the ends or from the top. Never touch the surface 
of the green drum inside the image drum unit.
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3. Carefully lift out the image drum, complete with the toner 
cartridge. Be careful not to touch or scratch the green 
drum surface. 

4. Put the assembly down gently onto a piece of paper to 
prevent toner from marking your furniture and to avoid 
damaging the green drum surface, and cover.  
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5. Remove any jammed sheets from the paper path.
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6. Remove the Duplex unit and check for any paper in this 
area. 
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7. Remove any paper and replace the duplex unit. 
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8. Re-install the image drum complete with toner cartridge, 
ensuring that the pegs (1) correctly locate into the slots on 
each side of the printer (2). 

9. Lower the top cover but do not press down to latch it 
closed yet. This will protect the drum from excessive 
exposure to room lighting, while you check the remaining 
area for jammed sheets.
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10. Lift the rear cover latch (1), open the rear cover and check 
for paper in the rear path. 

• Pull out any paper found in this area.

• If you are not using the rear cover, close it once the 
paper is removed from this area.
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11. B401/B411: Open the Manual Feed Tray and remove any 
paper that you find.
B431: Open the Multi Purpose Tray and remove any paper 
that you find. 

12. Close the tray.

13. Press down to latch the top cover closed. 
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14. The printer will warm up and commence printing when 
ready. The page lost through the jam will normally be 
reprinted.

Print quality problems
Before consulting a service representative regarding a print 
quality problem, check the table below to see if there is a 
solution, or something you might have overlooked.

Note
If the edge of the jammed paper protrudes (or can be 
seen) from the exit, reinstall the image drum, close 
the top cover and switch the printer on. Remove the 
jammed paper from the exit when the exit roller 
begins rotating after a few seconds after switching on. 
However, if the jammed paper cannot be removed, 
contact a service representative.

SYMPTOM PROBLEM SOLUTION

Blank sheets 
printed.

Image drum cartridge 
not properly installed.

Reinstall image drum 
cartridge.

Empty or missing toner 
cartridge.

Install new toner 
cartridge.

Entire page 
prints faintly.

Empty toner cartridge. 
Pages get fainter when 
toner is used up.

Install new toner 
cartridge.

 LED array is dirty. Clean LED array.

Page has grey 
background.

Static electricity, 
generally from dry 
environments, causes 
toner to stick to 
background.

Change paper to a 
smoother laser bond or 
use a humidifier.

Page prints all 
black.

Hardware problem. Contact service.
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Page has 
repetitive 
marks.

Damaged image drum 
cartridge causes 
repetitive marks every 
1.6 inches (4.06 cm) due 
to surface nicks and 
scratches.

Generate a cleaning 
page, repetitive marks 
may be temporary.

Oblong area 
of faint print 
appears on 
each page.

Drop out caused by 
using paper exposed to 
high humidity.

Change paper stocks, 
check paper storage 
environment or use a 
dehumidifier; check 
toner level.

Vertical white 
streaking or 
faint areas on 
page.

Toner is low and does 
not distribute properly, 
or the drum is worn out.

Replace toner 
cartridge. Check drum 
and replace the drum, 
if necessary. Contact 
service.

LED array is dirty. Clean LED array.

Vertical black 
lines.

Hardware problem. Contact service.

Fuzzy print. LED array is dirty. Clean LED array.

Distorted 
print.

Paper path, lamp 
assembly, or fusing unit 
problem.

Generate cleaning 
page.

Contact service.

Smeared or 
blotched 
print.

Dirty rollers; toner 
dropped inside printer or 
image drum problem.

Replace image drum 
and toner.

Contact service.

Printed page 
is light/
blurred.

Is toner low? Replace toner 
cartridge.

Is paper meant for laser 
printers?

Use recommended 
paper.

LED array is dirty. Clean LED array.

Bold 
characters 
and dark lines 
are smeared.

Toner is low. Install new toner 
cartridge.

SYMPTOM PROBLEM SOLUTION
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Print is darker 
than usual.

Darkness setting is too 
high.

Change darkness 
setting.

Pages curl 
excessively.

Printing on wrong side of 
paper.

Turn paper over in tray. 
(Note arrow on paper 
package). Install paper 
print side down in tray.

Moisture in paper. 
Improper storage.

Avoid storing paper in 
areas of excessive 
temperature and 
humidity. Store paper 
in protective wrapping.

High humidity. Recommended 
operating humidity: 20-
80%.

SYMPTOM PROBLEM SOLUTION
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Paper feed problems
SYMPTOM PROBLEM SOLUTION

Paper Jams 
occur 
frequently. 
Multiple 
sheets of 
paper are 
fed at the 
same time. 

The printer is tilted. Place the paper on a 
stable and flat surface.

Paper is too thick or too 
thin. Paper is moist, 
folded, creased or warped. 

Use paper suitable for 
the printer. Avoid 
storing paper in areas 
of excessive 
temperature and 
humidity. Store paper 
in protective wrapping

Paper is not aligned. Align the paper edges 
to the paper guides.

Only one sheet of paper is 
loaded in the Paper tray or 
Manual Feed/Multi Purpose 
tray.

Load several sheets of 
paper.

Sheets of paper is added 
to the existing paper stock 
in the Paper tray or Manual 
Feed/Multi Purpose tray.

Remove existing 
sheets of paper from 
the tray and add the 
new sheets to them, 
ensuring alignment 
and then load the tray.

Postcards, envelopes, label 
sheets or transparencies 
are loaded in the Paper 
tray.

Postcards or envelopes are 
placed in the wrong 
orientation.

You cannot print using 
the Paper tray. Load 
postcards, envelopes, 
label sheets or 
transparencies in the 
Manual Feed tray or 
Multi Purpose tray.

Check and load in the 
correct orientation.
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Paper is not 
fed into the 
printer.

Improper setting is 
selected for Paper Source 
in the printer driver.

Select the correct 
paper source from the 
Source drop down 
menu.

The printer menu setting is 
incorrect.

Set the size of the 
paper in the Setup 
Menu of the printer.

Printing does 
not resume 
after 
removing 
jammed 
paper.

Printing does not resume 
only by removing paper 
jam.

Open and close the top 
cover.

SYMPTOM PROBLEM SOLUTION
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Software problems
Your software (operating environment, applications and printer 
drivers) controls the printing process. Make sure you have 
selected the right driver for use with your printer. See your 
software documentation for more information.

Hardware problems

SYMPTOM PROBLEM SOLUTION

Printing is 
garbled.

Incorrect driver is installed. Install an appropriate 
driver.

Printer’s 
output is 
below rated 
speed.

Much of the printing delays 
will be caused by your 
application. Sometimes 
purely text documents will 
print slowly depending on the 
selected fonts and how they 
are transferred to the printer.

For maximum speed, 
use text in your 
document and use a 
printer resident font.

Size of top 
margin 
increases 
with each 
page 
printed.

Creeping text. Number of 
lines per page in software is 
not equal to number of lines 
per page of printer.

Many software 
packages assume 66 
lines per page, but your 
printer’s default is 64. 
Adjust software 
accordingly, or set 
LINES Per PAGE in the 
soft control panel to 
equal lines per page in 
your software.

SYMPTOM PROBLEM SOLUTION

Graphic image 
prints partly 
on one page, 
partly on the 
next.

Insufficient printer memory 
for this image at this 
resolution.

Change the 
resolution, reduce 
the image size, or 
install more memory 
in your printer.
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When you try 
to print 
nothing 
happens, but 
printer 
indicates it is 
ready to 
receive data.

Configuration error. Check cable 
connection. If more 
than one printer is 
available, make sure 
your printer has 
been selected.

Garbage 
prints.

Incorrect cable 
configuration. Also, see 
Software Problems.

Check cable 
configuration, 
continuity, and 
length.

Printer freezes 
or displays 
error message 
when 
computer is 
rebooted.

Booting the computer while 
the printer is on can cause 
a communications error.

Turn printer off 
before rebooting 
computer.

Odors. Gases are given off by 
forms or adhesives passing 
through the hot fusing unit.

Make sure the forms 
you use can 
withstand heating, 
and provide 
adequate 
ventilation.

Printer is on 
but must 
warm up 
before a job is 
printed.

Power Save mode is set on 
to conserve energy. The 
fuser must heat up before 
you can begin printing the 
next job.

To eliminate warm 
up delay, change 
Power Save setting.

SYMPTOM PROBLEM SOLUTION
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Options (B411/B431 only)
The following options are available to extend the performance of 
your printer:

• 64 and 256 MB RAM DIMM: to extend the main memory of 
your printer and speed up the processing of large files

• Second paper tray: to increase your printer’s paper handling 
capacity by 530 sheets (75g/m²)

Options order numbers  

Installation procedure
To install any of the above options, follow the detailed installation 
sheet that accompanies the option.

64 MB RAM DIMM 70062801

256 MB RAM DIMM 70062901

Second Paper Tray (Tan) 44575701

Second Paper Tray (Black) 44575704



Specifications

General
ITEM SPECIFICATION

Dimensions, 
W x D x H

15.2 x 14.3 x 9.6 inches
(387 mm x 364 mm x 245 mm )

Weight 26 lbs. (11.4 kg) approximately (without second 
tray)

Printing method Electro-photographic printing using LEDs as light 
source

Print color Monochrome

Print speed B401: 30 ppm for Letter; 29 ppm for A4

B411: 35 ppm for Letter; 33 ppm for A4

B431: 40 ppm for Letter; 38 ppm for A4

B431dn+: 47 ppm for Letter; 45.3 ppm for A4

Resolution B401/B411: 2400 x 600 dots per inch

B431: 1200 x 1200 dots per inch

Operating 
platform

Windows
2000/XP/XPx64 server 2003 x 64 bit edition/
Vista/Vista x 64 bit edition / Server 2008 / 
Server 2008 R2/ 7

Mac

OS X PowerPC (10.4 - 10.5) / OS X Intel (10.4.4 
- 10.7)

Unix/Linux

Emulations B401/B411: PCL5e, PCLXL, Epson FX, IBM 
ProPrinter

B431: PCL5e, PCLXL, Epson FX, IBM ProPrinter, 
PS3 
135 > B401/B411/B431



Interfaces Parallel port in compliance with IEEE 1284-1994 
standard

USB 2.0 High speed 

B401dn, B411dn, B431dn: 100BASE-TX/10Base-
T

Processor 330 MHz PowerPC

Memory 64 MB expandible to 320 MB (B411/B431 only)

Printer/Fuser life 200,000 pages or 5 years

Toner life Starter: 

B401dn: 1,000 pages

B411/B431: 2,000 pages

Replacement: (ISO/IEC19752)

B401:  1,500 pages

B411: 4,000 pages
B431: up to 10,000 pages

Image drum life B401
Simplex printing
25,000 pages (3 pages per job)

B411/B431:

Simplex printing

44,000 pages (continuous)
30,000 pages (3 pages per job)
17,500 pages (1 page per job)

Duplex printing

11,500 pages (continuous)
10,500 pages (6 pages per job)
8,500 pages (2 pages per job)

Paper sizes A4, A5, A6, B5, Letter, Legal 13, Legal 14, 
Executive, Custom, C5, C6, Com-9,Com-10, DL, 
Monarch, Statement

ITEM SPECIFICATION
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Paper feed B431: Automatic feeding via paper trays 
(including optional second tray and Multi Purpose 
Tray)

B411: Automatic feeding via paper trays 
(including optional second tray) and Manual 
feeding of single sheets

B401: Automatic feeding via paper tray and 
Manual feeding of single sheets

Paper feed 
capacity
at 20 lb. US Bond 
(75 g/m²)

B401, B411 and B431: Tray 1: 250 sheets

B411 and B431: Optional Tray 2: 530 sheets

B431: Multi Purpose Tray: 50 sheets 
B401 and B411: Manual Feed Tray: Single sheet 

Paper output Face up, face down depending on paper size, 
type and thickness

Power 
consumption

At 22°C

Typical: B401/B411: 510W, B431: 550W

Idle: 70W

Power save mode: 5W

Off mode:0.5w (230V-Model only)

Paper output 
capacity at 20 lb. 
US Bond (75 g/
m²)

Face down: 150 sheets

Face up: 100 sheets

Monthly duty 
cycle

B401/B411: 50,000 pages

B431: 80,000 pages

B431dn+: 100,000 pages

Consumables Toner cartridge, Image drum

Power cable Approximately 1.8 m max. length

Noise level Operation: 53 dB(A) 

Standby mode: 30 dB(A)

Power saving mode: Background level

ITEM SPECIFICATION
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Environmental 
conditions

Operation: 50 to 89°F (10 - 32°C), 20% - 80% 
RH, 

Storage: 50 to 109°F (10-43°C), 10% - 90% RH

When the printer is stored, it should be in its 
original packaging, with no moisture formation.

ITEM SPECIFICATION
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